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The item according to this mark describes the item to which the 
user needs to refer when performing the corresponding work.

※Warnings and cautions for safety

If the instructions following this symbol are not followed, serious 
accidents could occur, or death or serious injury of the operator 
could happen. Be sure to follow the instructions.Danger

If the instructions following this symbol are not followed, serious 
accidents could occur, or serious injury of the operator could 
happen. Be sure to follow the instructions.Warning

If the instructions following this symbol are not followed, damage 
of machine hardware, software, and data could occur or the 
operator could be injured. Be sure to follow the instructions.

Caution
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The overall process to operate the SM421 machine is as follows:

Overview - Operation Process

4

● Air pressure ● Rated voltage
● Foreign material inside the machine 
● Nozzle state ● Feeder ● Close doors
● Check safety state around the machine.

Turn on the main switch on the front 
side of the machine clockwise to sup-
ply power to the machine.

2. Turning on the main switch

If the MMI is executed, the program 
is initialized automatically and each 
module of the machine is checked.

3. MMI Initialization

The ‘Ready’ button to operate the 
machine. 

4.  Supplying the power to the     
      servomotor

Press the ‘Home Start’ button in the 
Teaching Box to return the machine to 
origin.

5. Returning to origin

The warm-up is performed for about 
10 minutes before starting the part 
placement in order to increase the 
placement accuracy of the machine.

6. Warm-up

Select and load the PCB file to work 
with.

7. Loading the PCB file

● Adjust conveyor width.
● Set the PCB fixing method.

8. Setting the conveyor

9. Arranging the backup pins

● Select the ‘Production’ menu of 
  the  MMI.
● Select the ‘Start’ submenu.
● Enter production amount in the  
   <Production Plan> edit box.
● Press the ‘Start’ button in OperationPanel.

10. Creating the PCB

Once the production is finished, click 
the <PCB Stop> button to finish the 
production.

11. Finishing the production

● Press the ‘Reset’ button.
● Click the <Exit> button.
● Turn off the main switch. 
   (counterclockwise).
● Put the surrounding of the working    
   area in order.

12. Turning off the machine 9. Arranging the backup pins

Arrange the backup pins at appropri-
ate positions so that they can support 
the bottom of the board.

1.  Checking the machine 
before starting the machine

Overview
SM421 Operation Handbook
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PART I Machine Overview

PART I. Machine Overview  This part describes the name of  each part, teaching box and the configuration of 
MMI(Man-Machine Interface).

AIR  PRESSURE

SAFEGUARD
OVERRIDE

MAIN  SWITCH

STOP

RESET

SELECT

FEEDERCHANGE

START

READY

[CH1]TRAY

NEXT

PREVIOUS

LAN

MCCB

GROUND

INTERFACE

[CH2]FEEDER

STOP

RESET

SELECT

FEEDERCHANGE

START

READY

Name of Each Part

1. Front view of the machine 2. Rear view of the machine



SM421 Operation Handbook

6

SM321

1

2

3

Indication of operation speed (5 steps)

Machine Overview  

Name of the Operation Panel 

Selects the operation speed  
in the Jog Mode.
▲ UP: Increase the speed
▼ Down: Decrease the speed

Changes over the Jog, Bang, 
Home and O.Line mode.

Turns on/off the vacuum of 
each head.

Selects the item to be operated.

Indicates the movement of each 
axis and rotation direction.

Emergency stop button
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PART I Machine Overview

Configuration of MMI

Machine Overview  

The configuration of MMI

Display the Shortcut-bar 

The PCB file name 
being worked on is 
displayed. 

A sub menu tool-
bar is shown.

Menu
● New
● Open
● Save/Save as
● Merge
● Exit
●  ErrorMsg Bar
●  Windows Tool

A main menu tool-bar is shown. The state of a Machine - ● IDLE
● RUN
● FREEZE
● WAIT
● PAUSE
● EMER

Displays the state of a Nozzle.
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Initialization (0)

Input production quantity

Indicates work progress

Change unit system

Product
Sub-Menu

Tab Dialog
Box

Machine Overview  

The configuration of 'production' screen

Configuration of MMI

Displays PCB 
Data

For the detailed description about each function of the ‘Production’ menu, refer to
‘11.1 Product Main’ of the ‘Administrator’s Guide’.
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PART I Machine Overview

9

Machine Overview  

The configuration of 'production' screen

‘Option Setting’ dialog box

‘Tape Feeder Monitor’ dialog box

‘My PCB’ dialog box
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3 Phase AC 220V ± 20V

Check if the rated voltage is correctly connected to the 
machine.

 Rating voltage

[CH1]TRAY

NEXT

PREVIOUS

LAN

MCCB

GROUND

INTERFACE

[CH2]FEEDER

STOP

RESET

SELECT

FEEDERCHANGE

START

READY

PART II. Power supply and Procedure Preparing for Production
This part describes how to supply the 
power and the items to be checked 
before starting production.

1. Rating voltage and connecting power source 

Procedure of Power Suppy (Check List)
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PART II Power supply and Procedure 
              Preparing for Production

For a detailed description of how to check and clean the nozzle, please refer to Chapter “Daily Inspection” in Maintenance manual.

- Select the appropriate nozzle according to the type and size of the part to be placed.

PART II. Power supply and Procedure Preparing for Production

2. Nozzle type and applied part

1. Type of nozzle

Nozzle 
name

CN020
(Option)

CN030
(Option)

CN040 CN065 CN140 CN220 CN400N CN750 CN110

External 
shape

Outside 
diameter Φ 0.5 Φ 0.6 Φ 0.75 Φ 1.2 Φ 2.2 Φ 3.6 Φ 6.2 Φ 9.0 Φ 12.7

Inside 
diameter Φ 0.16 Φ 0.28 Φ 0.38 Φ 0.65 Φ 1.4 Φ 2.2 Φ 4.0 Φ 7.5 Φ 11.0
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PART II. Power supply and Procedure Preparing for Production

2. Nozzle type and applied part

2. Nozzle type and applied part

- Select the appropriate nozzle according to the type and size of the part to be placed.

Nozzle 
name

Material 
number

Minimum part 
width Applied part

CN020 J90551006A 0.2 ~ 0.5 0402 Chip Dedicated

CN030 J90550133D 0.3 ~ 1.5 0603, 1005 Chip Dedicated

CN040 J90550134C 0.5 ~ 1.25 1005, 1608, SOT(Molded part 1.6 x 0.8)

CN065 J9055136C 0.8 ~ 2.5 2012, 3216, MELF(Molded part 1.2 X 2.0), SOT23

CN140 J9055256A 2.5 ~ 4.0
Aluminum electrolytic capacitor(Small-Size), Tantalum capacitor, 
Trimmer

CN220 J9055351A 4.0 ~ 7.0
Aluminum electrolytic capacitor(Medium-Size), SOP(Narrow), 
SOJ, Connector

CN400N J9055258B 7.0 ~ 10.0
Aluminum electrolytic capacitor(Large-Size), SOP(Wide), TSOP, 
QFP, PLCC, SOJ, Connector

CN750 J9055259B 10.0 ~ QFP(Medium-Size), PLCC(Medium-Size)

CN110 J9055260B 20.0 ~ QFP(Large-Size), PLCC(Large-Size)
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PART II Power supply and Procedure 
              Preparing for Production

PART II. Power supply and Procedure Preparing for Production

3. Turning on/off the main switch.
1. Turning on the main switch

- Turn Off - Turn On

2. Turning off  the main switch

- Turn off the 
   main Switch

- Press the ‘RESET’ 
  button

- Click the <EXIT> button
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[CH1]TRAY

NEXT

PREVIOUS

LAN

MCCB

GROUND

INTERFACE

[CH2]FEEDER

STOP

RESET

SELECT

FEEDERCHANGE

START

READY

PART II. Power supply and Procedure Preparing for Production

1. Inspections

Procedure Preparing for Production

1. Check the power connection 

- Be sure to check around and inside the machine before turning on the main switch.
- Check if there is any foreign matter such as a chip on the feeder base, and whether the feeder is correctly installed.
- Check if the nozzle is blocked with any foreign matter such as solder and the operation of the nozzle spring is smooth.
- Check whether the safety doors at the front and rear are open. If opened, close them.

Caution
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PART II Power supply and Procedure 
              Preparing for Production

AIR  PRESSURE

SAFEGUARD
OVERRIDE

MAIN  SWITCH

STOP

RESET

SELECT

FEEDERCHANGE

START

READY

PART II. Power supply and Procedure Preparing for Production

2. Check the air pressure
The Range of the rated pressure: 0.45~0.55MPa

1. Inspections 

Pressure Increase (Clockwise)

Pressure Decrease (Counterclockwise)

3. Check the main switch is on        

- Check the room temperature before turning on the first machine 
(Recommended temperature: above 20℃)

- If the temperature is below 20℃, ensure that the room
    temperature is 20℃. And then wait for 30 minutes before
    turning on the machine torevent the condensation of air.

Caution
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PART II. Power supply and Procedure Preparing for Production

2. MMI initialization

If the power is supplied to the machine, the PC is turned on and 
the MMI is executed automatically to check each module by 
initializing the program.

1. Turn on the main switch

2. Check the MMI initialization and module (automatically) 

3. Press the ‘READY’ button
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PART II Power supply and Procedure 
              Preparing for Production

SM321

1

2

3

PART II. Power supply and Procedure Preparing for Production

3. Return to origin (Homing)

When the machine is in ‘Ready’ state, it can be returned to
the origin. (homing)

1. Check if the light of the 'ready' button is on

2. Press the ‘Start’ button (▼)

3. It is returned to the origin
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PART II. Power supply and Procedure Preparing for Production

4. Warming-Up 

1. Selecting the ‘Utility’ Menu: Displays the Utility screen 2. Selecting the ‘Warmup’ submenu: Open the Warm Up   
    dialog box

The warm-up should be performed for about 10 minutes 
before starting the part placement in order to increase the 
placement accuracy.
Temperature condition: 20 ~ 28℃
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PART II Power supply and Procedure 
              Preparing for Production

3. Click the <Start> button. Perform the warm-up 4. Click the <Stop> button and close the dialog box after  
    performing the warm-up for about 10 minutes 

PART II. Power supply and Procedure Preparing for Production

4. Warming-Up 
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PART III. Production This part describes the production procedure.

1. Loading the PCB file

Preparation For Production

- Displays the ‘Product Monitor’ screen. - Displays its submenu.

1. Select the ‘Product’ menu 2. Click the ‘Open’ icon
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PART III Production

- Click the ‘Open’. - Select the PCB file to work with.

3. Click the ‘Open’ 4. Select the PCB file

PART III. Production

1. Loading the PCB file
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The file with extension of .opt is the optimization completed file. 

- The PCB file loading is complete. 

5. The completion of loading the PCB file

PART III. Production

1. Loading the PCB file
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PART III Production

2. Setup the conveyor

PART III. Production

1. Select the ‘PCB Edit’ menu 2. Select the ‘Board’ submenu

Adjusting the conveyor width 1
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PART III. Production

3. Enter the X and Y size of PCB in the <7.Board Size> group 4. Click the <Conv. Width> button

Adjusting the conveyor width1
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PART III Production

Edge Fixer1: A method of alignment by pushing the PCB from the side 
with a device attached on the conveyor.

Edge Fixer2: It is the same as the “Edge Fixer” method, but it is a method 
of pushing twice from the side.

None: It uses only the PCB clamping method for fixing a PCB.

PCB fixing method setup: Select the method to align the PCBs3

The ‘Fix Type’ is selected based on the weight of the PCB. If the 
weight of the PCB is more than 1kg, select the Edge Fixer 2.

PART III. Production

2. Setting conveyor
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For detailed information 
about backup pin 
arrangement, please refer 
to p. 57, ‘Arranging Backup 
Pins’ in ‘Additional Check 
Points’, <PART VI>.

Arranging the backup-pins4

1. Open front/rear safety door (and press the 'EMG' switch)

2. Press the 'STOP' button

Before arranging the 
backup pins, power 
off the motor.

Warning

3. Press the 'RESET' button

4. Install the backup pins to support the PCB.

Arrange the backup 
pins after moving 
the backup table up.Warning

PART III. Production
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PART III Production

PART III. Production

5. Close the front/rear safety door 6. Press the 'READY' button

The backup-pin arrangement 4
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PART III. Production

1. Loading the PCB file

Production

1. Select the ‘Product’ menu 2.  Select the ‘Start’ submenu (F2)

- Displays the ‘Product Monitor’ screen. - If the ‘Start’ submenu is selected, the PCB program is downloaded 
  automatically.
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PART III Production

1. Press ‘Start’ button in the operation pannel.

PART III. Production

2. Starting production (Automatic production)production

- Starts production.

Check if there is a worker around the machine before starting 
production.Warning
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PART III. Production

2. Starting production (Quantity designated production)

Set the total number of PCBs to be worked in the <Production 
plan> edit box. If the value becomes 0, the production is stopped.

-  Select the ‘Start’ submenu after setting the total number of PCBs to be 
worked in the <Production plan> edit box

1. Set the production quantity 2. Press ‘Start’ button in the operation pannel.

- Starts production.

Check if there is a worker around the machine before starting 
production.Warning
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PART III Production

PART III. Production

1. Finishing the Production and shutting down the machine

Finishing the Production

1. Click the <PCB Stop> button 2. Press the 'RESET' button

-  Clicking this button during production will stop the production after
  finishing the Production of the PCB on work.

- Changes the machine status into the
    'IDLE' mode
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-To save the changes and exit MMI, click <Yes> button.

PART III. Production

- Click the 'Exit' icon in the 'File' menu to close the MMI.

3. Click the 'Exit' icon in the 'File' menu 4. Shut down the machine

1. Finishing the production and shutting down the machine
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PART III Production

33

- Turn off the main switch on the front of 
the machine when the power of PC is 
off.

5. Turn off the main switch

1. Finishing the Production and shutting down the machine

PART III. Production
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PART IV. How to stop the machine in emergency
This part describes the methods for temporary stop of the machine 
(Continue / Start mode), emergency stop (by manual/ by system) and the 
restarting the production after emergency stop when checking errors or 
other items and taking measures during production. 

1. Continue mode: Halts the production temporarily and then restarts the production

Temporary stop

In order to restart the production in the Continue Mode, the occurred error must not 
be the one that does not allow the production to be started again.

Press the 'RESET' button and chanege the machine status 
into the 'IDLE' mode.

1.  Select the ‘Stop’ submenu or press the ‘STOP’ button of the
    operation panel to stop the production

2. Press the 'RESET' button
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PART IV How to stop the machine in     
               emergency

PART IV. How to stop the machine in emergency

3. Select the ‘Cont.’ submenu 4. Take measures against the error

Check the necessary items, take action, and select 'Cont.' submenu.
Resume the production by pressing the 'START' 
button.

1. Continue mode: Halts the production temporarily and then restarts the production
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AIR  PRESSURE

SAFEGUARD
OVERRIDE

MAIN  SWITCH

SAFEGUARD
OVERRIDE

MAIN  SWITCH

STOP

RESET

SELECT

FEEDERCHANGE

START

READY

PART IV. How to stop the machine in emergency

1. Press the 'RESET' button 2. Press the 'READY' button

2. Start mode: Restarts the production after the occurrence of an error

3.  Take measures against the 
error

When the machine stops due to an error, the machine is in the ‘FREEZE’ mode. Change the machine status into the ‘IDLE’ mode in order to 
take measures against the error.

Releasing the 'FREEZE' Mode.1
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PART IV How to stop the machine in     
               emergency

PART IV. How to stop the machine in emergency

1. Select the ‘Start’ submenu

Restarting the production2

When the production is restarted after taking measures against the error, all motors of the machine is returned to the origin and performs the work
from the beginning.

2. System emergency stop: How to take measures against the emergency stop due to the judgment of the system itself

2. Start the production again by pressing the  
     'START' button
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SM321

1

2

3

PART IV. How to stop the machine in emergency

1. The emergency stop by operator

Emergency Stop

Be sure to remove the cause of emergency stop before 
restarting Warning

1. Press the ‘EMG’ switch on operation panel or the ‘MOTOR FREE’ button on the teaching box

The emergency stop by operator1
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PART IV How to stop the machine in     
               emergency

PART IV. How to stop the machine in emergency

Releasing 'Emergency Stop' mode2

1. Release the pressed ‘EMG’ switch by turning clockwise 2. Press the ‘STOP’ button

1. The emergency stop by operator
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AIR  PRESSURE

SAFEGUARD
OVERRIDE

MAIN  SWITCH

SAFEGUARD
OVERRIDE

MAIN  SWITCH

STOP

RESET

SELECT

FEEDERCHANGE

START

READY

PART IV. How to stop the machine in emergency

3. Find the cause of the emergency  
    stop, and remove it

4. Press the 'RESET' button 5. Press the 'READY' button

Releasing 'Emergency Stop' mode2

In case that the machine stops in an emergency state and then the production is restarted, the operator must check if there is any 
component on the PCB due to emergency stop before pressing the 'READY' button. If he/she finds any, it must be removed.

Caution
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PART IV How to stop the machine in     
               emergency

PART IV. How to stop the machine in emergency

1. Press the ‘STOP’ button to turn off the buzzer 2. Check the error information displayed on the monitor of  
     the machine.

2. System emergency stop: How to take measures against the emergency stop due to the judgment of the system itself
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SM421

PART IV. How to stop the machine in emergency

3. Check the error by referring to the ‘Troubleshooting  
    Guide’ and take measures

4. Press the ‘RESET’ button to change the machine  
     operation mode into the ‘IDLE’ mode.

2. System emergency stop: How to take measures against the emergency stop due to the judgment of the system itself

In case that the machine stops in an emergency state and then the production is restarted, the operator must check if there is any 
component on the PCB due to emergency stop before pressing the 'READY' button. If he/she finds any, it must be removed.

Caution
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PART IV How to stop the machine in     
               emergency

43

In the case of an error against which the user can not take measures, inform the manager of it and contact our C/S or the 
loacl agent.
If the work is stopped due to emergency stop, take measures against the error and start the work again from the 
beginning.

5. Press the ‘READY’ button to supply power to the motor  
    of the machine.

6. Return the machine to the origin, if necessary.

PART IV. How to stop the machine in emergency

2. System emergency stop: How to take measures against the emergency stop due to the judgment of the system itself
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PART V. Changing Jobs This part describes the basic SMT In-Line work process and the method to change the 

work from the existing work to the new one during operation.

SMT In-Line Process

Work 
Sequence In-Line System Measures

1 Screen Printer
Machine Stop → Metal Mask Removal/ Washing → Backup Pin Removal 
→ New Work File Loading → Backup-Pin Rearrangement → Conveyor Width 
Adjustment → Metal Mask Installation → Solder Check/ Make-up

2 Component Placer For more details, refer to the section entitled Changing Jobs on the next page.

3 Magazine Loader Adjust the conveyor width according to the width of the PCB to be newly worked on

4 Work Table Adjust the conveyor width according to the width of the PCB to be newly worked on

5 Magazine Unloder Adjust the conveyor width according to the width of the PCB to be newly worked on.

6 Reflower Conveyor Width Adjustment → Test Production → Setups for Temperature and 
othersMagazine Unloader

Magazine Loader Screen Printer Component Placer Component Placer Work Table Reflower
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PART V Changing Jobs

SM421 Operation Handbook

Changing Jobs

PART V. Changing Jobs

1. Changing the machine status into the 'IDLE' mode

1 Press the 'STOP' button Press the 'RESET' button2 Check if the machine is in the 'IDLE' mode3
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PART V. Changing Jobs

2. Removing the feeder

Pull the grip back.1 Remove the cover tape.2 Remove the feeder.3
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PART V Changing Jobs

SM421 Operation Handbook
PART V. Changing Jobs

4. Loading the PCB file 6. Adjusting the conveyor width

3. Clean the feeder base 5. Remove backup-pin

Load a new PCB file. For more details, refer to 'Loading 
the PCB file' of 'PART III. Production'. 

Adjust the conveyor width according to the new PCB. For 
more details, refer to 'Adjusting  the conveyor width' of 
'PART III. Production'. 

Remove the chips or other foreign matter on the feeder base 
upper surface and in the slot by using the provided brush or 
another small brush.

Before removing the backup-pin, power off the 
motor. 

Warning
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8. Install the feeder

9. Production

7. Backup-pin rearrangement

PART V. Changing Jobs

For detailed information about backup pin arrangement, please 
refer to p. 57, ‘Arranging Backup Pins’ in ‘Additional Check 
Points’, <PART VI>.

① Fixing the feeder in the slot ② Fixing the grip

- Arrange the backup pins after moving the backup 
table up.

- If the double-faced board is on work, placing 
the backup pins wrongly could lead to improper 
placement or damage the placed components. 
Be sure to adjust the backup pins position correctly.

Caution

Install the feeders in the feeder base by referring to the above feeder 
installation method

Perform the new production
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PART V Changing Jobs

SM421 Operation Handbook

MEMO
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1. Checking reel hanger

Checking Feeder

PART VI. Additional Check Points This Part provides the troubleshooting measures for the problems 
that can occur during machine operation.

Check Points
After mounting the feeder, make sure the reel hanger 
is in contact with the inside of the feeder.
Make sure the reel hanger rib sits on the reel properly.

Reel hanger rib guides the reel to feed properly.  If the rib is out of the reel, feeding error may occur.
Caution
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PART VI Additional Check Points

51

2. Checking locker

Push

Tape Guide

Locker

Check Points
After mounting the part reel on the feeder, make sure 
the locker is properly locked.

PART VI. Additional Check Points

If the tape guide and the locker are not locked properly, it may collide with the head during operation.
Caution
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3. Checking part reel

100mm

A

B
50mm

Check Points
For smooth feeding of the parts, make sure the 
following conditions are met when you mount the part 
reel on the feeder.

100mm

A

50mm

B

The tape should extend more than 
100 mm from the part adhesion 
point.

The vinyl should extend more than 
50 mm from the center of the drain 
gear.

PART VI. Additional Check Points

If the part reel is not mounted as in the figure, index error may occur.
Caution
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PART VI Additional Check Points

53

4. Checking if the feeder is properly mounted on the feeder base

1. Check the probe pins of the feeder. 3. Check the LED color of the feeder.2. Secure the grip after mounting the 
    feeder.

PART VI. Additional Check Points

When properly installed, the LED color is green. If the LED color is not green even when the feeder is properly mounted, 
contact the A/S center.Caution
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5. Setting the pickup height of the parts

Check Points
You should set the pickup height differently depending 
on whether the part is fed by the paper tape reel or by 
the emboss tape reel.
Please refer to the figure on the left when you set the 
pickup height of the parts.
For detailed information, please refer to “1.3 Reference 
plane for the z-axis height of SM tape feeder (p. 1-8)” 
in the SM feeder manual.

Example
Paper Type: 1608R -> Z=0.5
Emboss Type: Z=-0.1

- To set the pickup height of the parts, select ‘PCB Edit’ > ‘Feeder Z Pickup’ in MMI.

PART VI. Additional Check Points
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PART VI Additional Check Points

55

6. Operating the machine after changing the reel

- When you close the reel arm after reel change, you should lift it slightly.

Check Points
The machine will operate only if you lift the reel arm 
upwards when you close the reel hanger.

Slow Swing

PART VI. Additional Check Points

If you try to close the arm too hard, you may damage the reel stopper.
Caution
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7. Precautions that need to be taken when you check the reel information

If you try to move the reel arm plate sideways as shown in the 
figure below, the reel arm plate may bend.

RWhen you check the reel information, you should open (lift) 
the reel arm plate first.

PART VI. Additional Check Points

1.You should open the reel arm before you can check 
   the reel information.

Caution
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1. Determining the positions of the backup pins

Arranging Backup Pins

1. Place the master PCB in the conveyer.

Master PCB

A. Place the backup pins on both sides where
     the PCB is bent the least.

Manufacturing master PCB
Master PCB prevents interference 
between backup pins and parts.
For a double-faced PCB, a master PCB 
is manufactured which has a hole in 
the bottom area where the parts are 
mounted.

- When you place the backup pins, you should avoid the hole in the PCB.

Before removing the backup-pin, power off 
the motor. 

2. Arrange backup pins.

B. Place the backup pins where the parts are
    mounted in the central area .

The number of backup pins
For a 200 mm-wide PCB, usually 6 
backup pins are used.

PART VI. Additional Check Points

Warining
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2. Setting the height of backup pins

1. Set the height of the backup pins in the sides. 2. Set the height of the backup pins in the central area.

-You should set the height of backup pins after securing the master PCB in the conveyer.

-Set the height so that the pins are in contact with the sides of the PCB. -Set the height of the central backup pins so that they are on the same
  level with the pins on both sides.

PART VI. Additional Check Points
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3. Checking the flatness of the PCB

1. Checking the flatness of the PCB in a diagonal direction 2. Checking the flatness of the PCB in a horizontal direction

- Place and secure the PCB in the conveyer.  Then, check if the PCB is flat using a ruler.

- Use a ruler to check if the PCB is flat diagonally. - Use a ruler to check if the PCB is flat in three horizontal positions.

PART VI. Additional Check Points

If the PCB is not flat, the parts may not be properly placed.  If the PCB is not flat, reset the height of the backup pins.
Caution
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